Users’ Guide

Tax Optimizer

InteractiveBrokers
Tax Optimizer Users' Guide

August 2017

© 2017 All Rights Reserved

Any symbols displayed within these pages are for illustrative purposes only, and are not intended to portray any recommendation.
Contents

Tax Optimizer Users’ Guide ................................................................. 3

Overview ......................................................................................... 3

Tax Basis Declaration and the Tax Optimizer ..................................... 4

About Tax Lot Selection ..................................................................... 4

Lot-Matching Methods ...................................................................... 5

Examples .......................................................................................... 7

Basic Scenario .................................................................................. 7

FIFO Lot-Matching .......................................................................... 7

LIFO Lot-Matching ........................................................................... 9

Maximize LT Gain ............................................................................ 9

Maximize LT Loss ........................................................................... 10

Maximize ST Gain ........................................................................... 11

Maximize ST Loss ........................................................................... 12

Highest Cost Example ....................................................................... 13

Basic Scenario ................................................................................ 13

Launching the Tax Optimizer .......................................................... 14

The Tax Optimizer Window .............................................................. 17

Main Window ................................................................................... 17

Tax Lot Details Panel ....................................................................... 18
Overview

The Tax Optimizer is a tool available within Account Management that lets you manage your stock, option, bond, warrant, single-stock future and mutual fund gains and losses for tax purposes.

Specifically, the Tax Optimizer lets you select one of several tax lot-matching methods to:

- Change the default tax lot-matching method for your account.
- Change the default tax lot-matching method for the current or prior trading day.
- Change the tax lot-matching method for a specific symbol for the current or prior trading day.
- Run real-time what-if scenarios - change the lot-matching method on the fly to immediately see the effect on your gains and losses.
- Manually match specific sales to open tax lots for the current or prior trading day.

Futures (but not Single Stock Futures) and options on futures always use FIFO.

In addition, you can view a year-to-date (YTD) summary screen, which shows your YTD short-term and long-term profit and loss, unrealized profit and loss, and total profit and loss by symbol. You can change your account default lot-matching method and today's lot-matching method from the YTD summary.
Chapter 4  Tax Basis Declaration and the Tax Optimizer

All profit and loss amounts in the Tax Optimizer are converted to the base currency of your account. However, prices are NOT converted to your base currency.

Tax Basis Declaration and the Tax Optimizer

The Tax Basis Declaration page, available in the reporting section of Account Management, lets you change the default tax lot-matching method for your account. This function in the Tax Optimizer replaces the same function on the Tax Basis Declaration page, so you will no longer have access to the Tax Basis Declaration page in Account Management. You will be able to change the default tax-lot matching method on the Tax Optimizer page in Account Management OR in the Tax Optimizer.

For more information

» [About Tax Lot Selection](#)
» [Lot-Matching Algorithms](#)

About Tax Lot Selection

Most taxpayers recognize capital gain or loss for tax purposes when they close a position. If an asset is sold for less than its purchase price, then the difference is considered a capital loss. If an asset is sold for more than its purchase price, then the difference is considered a capital gain. Gain or loss is equal to proceeds minus the adjusted cost basis of the position.

Gain or Loss = Proceeds – Adjusted Cost Basis for Each Tax Lot

Gains and losses resulting from trades are based on “matching lots.” A tax lot is the record of details of a purchase. Each acquisition of a security, on a different date or at a different price, constitutes a tax lot. Tax lots are used to determine the cost basis and holding period when you dispose of securities.

When you sell a security, if you don’t sell all of the shares that you own you must match the sale to a tax lot or lots in order to determine your gain or loss as well as your holding period.

The IRS allows two basic methods for matching tax lots: First in, First out (FIFO) and Specific Identification.
FIFO is the default method that will be applied if you do not choose another method. Under FIFO, the sale is matched with the earliest purchased lot or lots available.

Specific Identification allows a trader to match sales with purchases in a different order than FIFO, as long as he or she can show that the tax lots were selected at the time of the sale. The Tax Optimizer lets you choose a method until 8:30 PM ET on the day of the trade.

The Tax Optimizer lets you use Specific Identification directly by letting you change the tax lot-matching method for a specific position, and manually select tax lots to match. You can also use Specific Identification by choosing among several available lot matching algorithms.

Once lots have been matched, the gain or loss for that lot equals the proceeds minus the adjusted cost basis for each lot.

The period from the purchase to the sale is the holding period.

Gains or losses from securities held for one year or less are generally short-term and are taxed at ordinary income rates.

Gains or losses from securities held for more than one year are long-term and may be eligible for preferred rates.

Lot-Matching Methods

The Tax Optimizer lets you select one of the following lot-matching algorithms when changing the matching method or running what-if scenarios:

**First In, First Out (FIFO)** - The default method for matching tax lots. Sales are paired with the earliest purchases sequentially. FIFO assumes that assets remaining in inventory are matched to the most recently purchased or produced assets. FIFO is always used for futures and options on futures.

**Last In, First Out (LIFO)** - Each sale is paired with the most recent possible purchase. LIFO assumes that an entity sells, uses or disposes of its newest inventory first.

**Maximize Long-Term Gain** - Sales are paired based on the following set of priorities:

1. Maximize Long-Term Gain per share
2. Maximize Short-Term Gain per share
3. Minimize Short-Term Loss per share
Chapter 4
Lot-Matching Methods

4. Minimize Long-Term Loss per share

**Maximize Long-Term Loss** - Sales are paired based on the following set of priorities:

1. Maximize Long-Term Loss per share
2. Maximize Short-Term Loss per share
3. Minimize Short-Term Gain per share
4. Minimize Long-Term Gain per share

**Maximize Short-Term Gain** - Sales are paired based on the following set of priorities:

1. Maximize Short-Term Gain per share
2. Maximize Long-Term Gain per share
3. Minimize Long-Term Loss per share
4. Minimize Short-Term Loss per share

**Maximize Short-Term Loss** - Sales are paired based on the following set of priorities:

1. Maximize Short-Term Loss per share
2. Maximize Long-Term Loss per share
3. Minimize Long-Term Gain per share
4. Minimize Short-Term Gain per share

**Highest Cost** - Seeks to maximize losses while minimizing gains. Sales are paired based on the following rules:

- First, it looks at all possible options for matching a closing trade to an open lot.
- If any possible matches would result in a loss, the method chooses the match that results in the largest possible loss.
- If no possible match would result in a loss, the method chooses the match that results in the smallest possible gain.

**Specific Lot** - Lets you see all of your tax lots and closing trades, then manually match lots to trades. Specific Lot is available for today or a position, but not it is available as the Account Default Match Method.
Examples

This topic presents an example of a group of trades and what the gain and loss would be under each of the following six lot-matching methods:

- FIFO (First In, First Out)
- LIFO (Last In, First Out)
- Maximize LT Gain
- Maximize LT Loss
- Maximize ST Gain
- Maximize ST Loss
- Highest Cost

Basic Scenario

A customer makes the following purchases:


The same customer makes the following sales:

- Sale 1: April 15, 2012 at 10:00AM: 1 share of ABC at $25.
- Sale 2: April 15, 2012 at 12:00PM: 1 share of ABC at $35.
- Sale 3: April 15, 2012 at 2:00PM: 1 share of ABC at $15.

FIFO Lot-Matching

Under the FIFO lot-matching method:
Sale 1 is matched with Lot 1 for a long-term gain of $15.
Sale 2 is matched with Lot 2 for a long-term loss of $5.
Sale 3 is matched with Lot 3 for a short-term loss of $15.

The customer therefore has a net long-term gain of $10, a net short-term loss of $15, and a basis of $20 and holding period starting July 15, 2011 for the remaining open lot.
LIFO Lot-Matching

Under the LIFO lot-matching method:

- Sale 1 is matched with Lot 4 for a short-term gain of $5.
- Sale 2 is matched with Lot 3 for a short-term gain of $5.
- Sale 3 is matched with Lot 2 for a long-term loss of $25.

Customer has a net long-term loss of $25, a net short-term gain of $10, and a basis of $10 and holding period starting January 15, 2011 for the remaining open lot.

Maximize LT Gain

Under the Maximize LT Gain lot-matching method:

- There are four possible matches for Sale 1:
  - Lot 1 would result in a long-term gain of $15
  - Lot 2 would result in a long-term loss of $15
  - Lot 3 would result in a short-term loss of $5
  - Lot 4 would result in a short-term gain of $5

The only possible long-term gain for Sale 1 is Lot 1, so Sale 1 would be matched with lot 1 for a long-term gain of $15.

- There are three possible matches for Sale 2:
  - Lot 2 would result in a long-term loss of $5.
  - Lot 3 would result in a short-term gain of $5.
  - Lot 4 would result in a short-term gain of $15.

None of the possible matches results in a long-term gain. The second priority for the Maximize LT Gain matching method is to maximize short-term gain.

Sale 2 would be matched with Lot 4 for a short-term gain of $15.

- There are two possible matches for Sale 3:
  - Lot 2 would result in a long-term loss of $25.
  - Lot 3 would result in a short-term loss of $15.
Maximize LT Loss

None of the possible matches results in a long-term gain and none of the possible matches results in a short-term gain, so the matching method chooses based on its third priority, minimize short-term loss.

Sale 3 is matched with Lot 3 for a short-term loss of $15.

Customer has a net long-term gain of $15, no net short-term gain or loss, and a basis of $40 and holding period beginning on March 15, 2011 for the remaining open lot.

Maximize LT Loss

Under the Maximize LT Loss lot-matching method:

- There are four possible matches for Sale 1:
  - Lot 1 would result in a long-term gain of $15.
  - Lot 2 would result in a long-term loss of $15.
  - Lot 3 would result in a short-term loss of $5.
  - Lot 4 would result in a short-term gain of $5.

The only possible long-term loss for Sale 1 is Lot 2, so Sale 1 is matched with Lot 2 for a long-term loss of $15.

- There are three possible matches for Sale 2:
  - Lot 1 would result in a long-term gain of $25.
  - Lot 3 would result in a short-term gain of $5.
  - Lot 4 would result in a short-term gain of $15.

None of the possible matches results in a long-term loss. The second priority for the Maximize LT Loss matching method is to maximize short-term loss. None of the possible matches results in a short-term loss.

The third priority for the Maximize LT Loss macro is to minimize short-term gain.

Sale 2 is matched with Lot 3 for a short-term gain of $5.

- There are two possible matches for Sale 3:
  - Lot 1 would result in a long-term gain of $5.
  - Lot 4 would result in a short-term loss of $5.
None of the possible matches results in a long-term loss. The second priority for Maximize LT Loss is maximize short-term loss.

*Sale 3 is matched with Lot 3 for a short-term loss of $15.*

*Customer has a net long-term loss of $15, no net short-term gain or loss and a basis of $10 and holding period starting January 15, 2011 for the remaining open lot.*

**Maximize ST Gain**

Under the Maximize ST Gain lot-matching method:

- There are four possible matches for Sale 1:
  - Lot 1 would result in a long-term gain of $15.
  - Lot 2 would result in a long-term loss of $15.
  - Lot 3 would result in a short-term loss of $5.
  - Lot 4 would result in a short-term gain of $5.

*The only possible short-term gain for Sale 1 is Lot 4, so Sale 1 would be matched with Lot 4 for a short-term gain of $5.*

- There are three possible matches for Sale 2:
  - Lot 1 would result in a long-term gain of $25.
  - Lot 2 would result in a long-term loss of $5.
  - Lot 3 would result in a short-term gain of $5.

*The only possible short-term gain for Sale 1 is Lot 3, so Sale 2 is matched with Lot 3 for a short-term gain of $5.*

- There are two possible matches for Sale 3:
  - Lot 1 would result in a long-term gain of $5.
  - Lot 2 would result in a long-term loss of $25.

None of the possible matches results in a short-term gain. The second priority for the Maximize ST Gain matching method is to maximize long-term gain.

*Sale 3 is matched with Lot 1 for a long-term gain of $5.*
Customer has a net long-term gain of $5, a net short-term gain of $10, and a basis of $40 and holding period beginning on March 15, 2011 for the remaining open lot.

Maximize ST Loss

Under the Maximize ST Loss lot-matching method:

- There are four possible matches for Sale 1:
  - Lot 1 would result in a long-term gain of $15.
  - Lot 2 would result in a long-term loss of $15.
  - Lot 3 would result in a short-term loss of $5.
  - Lot 4 would result in a short-term gain of $5.

The only possible short-term loss for Sale 1 is Lot 3, so Sale 1 is matched with Lot 3 for a short-term loss of $5.

- There are three possible matches for Sale 2:
  - Lot 1 would result in a long-term gain of $25.
  - Lot 2 would result in a long-term loss of $5.
  - Lot 4 would result in a short-term gain of $15.

None of the possible matches results in a short-term loss. The second priority for the Maximize ST Loss matching method is to maximize long-term loss.

Sale 2 is matched with Lot 2 for a long-term loss of $5.

- There are two possible matches for Sale 3:
  - Lot 1 would result in a long-term gain of $5.
  - Lot 4 would result in a short-term loss of $5.

Sale 3 is matched with Lot 4 for a short-term loss of $5.

Customer has a net long-term loss of $5, net short-term loss of $10 and a basis of $10 and holding period starting January 15, 2011 for the remaining open lot.
Highest Cost Example

This topic presents an example of the Highest Cost tax lot-matching method.

<table>
<thead>
<tr>
<th>Basic Scenario</th>
</tr>
</thead>
<tbody>
<tr>
<td>A customer makes the following purchases:</td>
</tr>
<tr>
<td>Lot 1: Dec 1, 2010: 200 Shares of ABC for $1,600 total.</td>
</tr>
<tr>
<td>Lot 2: June 30, 2012: 200 Shares of ABC for $2,000 total.</td>
</tr>
<tr>
<td>Lot 3: Dec 14, 2012: 200 Shares of ABC for $2,400 total.</td>
</tr>
</tbody>
</table>

On December 15, 2012, the same customer makes the following sales and selects Highest Cost as the lot-matching method for ABC:

- Sale 1: 10:00 AM: 200 Shares of ABC for $1,900 total.
- Sale 2: 11:00 AM: 100 Shares of ABC for $1,100 total.

There are three possible matches for Sale 1:

- Lot 1, which would result in a $300 (long-term) gain.
- Lot 2, which would result in a $100 (short-term) loss.
- Lot 3, which would result in a $500 (short-term) loss.

Sale 1 is matched with Lot 3, because that match results in the largest possible loss.

There are two possible matches for Sale 2:

- Lot 1, which would result in a $300 (long-term) gain.
- Lot 2, which would result in a $100 (short-term) gain.

Sale 1 is matched with Lot 2, because that match results in the smallest possible gain.
Launching the Tax Optimizer

The Tax Optimizer is available from within Account Management.

To launch the Tax Optimizer

1. Log into Account Management by selecting Account Management from the Login menu on our web site.

   The Account Management Login screen appears.
You can also launch Account Management by logging into Trader Workstation, then selecting **Account Management Home** from the Account menu.

2. Click **Reports > Tax > Tax Optimizer**. The Tax Optimizer page opens.
3. Select the Trading Day. You can select the current trading day or the prior trading day. Note that if you are launching the Tax Optimizer on a Saturday or Sunday, you will only be able to select the prior trading day.
4. Click Launch.
5. You are prompted to open the file *ibto.jnlp*. Depending on your web browser, click Open or OK to open the file.

The Tax Optimizer opens.
The Tax Optimizer Window

The Tax Optimizer has three main sections:

» Main Window
» Tax Lot Details Panel
» Match Details Window
» Year-to-Date Summary

Main Window

When you first open the Tax Optimizer, the screen displays:

» Information about your profit and loss for the current day or the prior day (depending on your selection in Account Management) as well as the current trade date and the amount of time remaining until you can no longer change your tax lot-matching method for today.
» The default matching method for your account and the default matching method for today. If you change the matching method for today, it overrides the account default matching method for today only.
» Available security types. You select a security type to view today’s positions for that type only. Select stocks, options, bonds, warrants or single-stock futures (SSFs).
» YTD Summary tab, located next to the available security types. Select the YTD Summary tab to view a table of all your positions and their year-to-date profit and loss.
» A list of your positions, and the current day’s short term and long term profit and loss for each symbol. Click the Show button for any position to open the Tax Lot Detail panel for that symbol.
Chapter 4

Tax Lot Details Panel

The Tax Lot Details panel opens in the bottom half of the main window when you click the Show button for any position listed.

1099-eligible customers only - The Price for lots affected by wash sales displayed in the Tax Lot Details panel is derived from the adjusted cost basis for the wash sales, if applicable. However, same-day wash sales are not included.

The Tax Lot Details panel displays:

» All open lots and closing trades for the selected symbol, including tax lots spawned by voluntary corporate actions that are booked at approximately 7:00 PM ET.

» The profit and loss for each open lot that is closed under the current matching method.

» A Show or Edit button next to each open lot or closing trade. This button opens the Match Details window. The Edit button appears only when the matching method is set to Specific Lot, which lets you manually match sales to open lots.

For a more detailed description of this screen, see Part of the Screen.
Match Details Window

The Match Details window opens on top of the main window when you click Show or Edit for a specific tax lot in the Tax Details Panel. The Match Details window is where you manually match sales to open lots (only when the matching method is Specific Lot). The Match Details window displays:

- The open lot you selected in the Tax Details Panel.
- All possible sales that could be matched to that open lot.
- For lots whose matching method is Specific Lot, a Quantity field in which you enter the number of shares or contracts to match. This is how you manually match sales to open lots.
Parts of the Screen

The figure below shows the parts of the Tax Optimizer screen, which are described in the numbered items that follow.

All profit and loss amounts in the Tax Optimizer are converted to the base currency of your account. However, prices are NOT converted to your base currency.
**File and Help Menus**

1. **Account menu** - shows the P/L (profit and loss) the current day or the prior day (depending on your selection in Account Management), short term and long term gain. The time remaining in hours:minutes until 8:30 PM ET (the cutoff time for changing the lot-matching method for any tax lot), and the current trade date appear on the right side of the bar. For multi-account structures (institutional accounts with client or sub accounts, for example), the Information Bar also contains an Account drop-down, which lets you select the account for which you want to optimize your gains and losses.
### Account Default Match Method
The default matching method for your account. Change this by clicking the drop-down and selecting a different method. Select from FIFO, LIFO, Maximize LT Gain, Maximize LT Loss, Maximize ST Gain, Maximize ST Loss or Highest Cost. When you click the Save button, the method you select will be applied to all positions and will override any choice previously made for today's matching method or any specific security. Note that futures and options on futures always use FIFO as their match method, regardless of the Account Default Match Method.

### Today's Match Method
The matching method for today. Change this by clicking the drop-down and selecting a different method. Select from FIFO, LIFO, Maximize LT Gain, Maximize LT Loss, Maximize ST Gain, Maximize ST Loss, Highest Cost or Specific Lot. When you click the Save button, the method you select will be applied to all positions for today and will override any choice previously made for any specific security.

### Save Button
Saves all changes you made to lot-matching methods.

### Refresh Button
Updates all data in the Tax Optimizer.

### Security Type
The security type for the displayed list of positions. Change the Security Type by clicking the appropriate tab: select Stocks, Options (including Structure Products), Bonds (including Bills), Warrants, SSFs (Single-Stock Futures) or Funds to view all positions of that security type.

### List of Positions
All positions of the selected security type, sorted alphabetically by symbol and showing the matching method, Short Term P/L and Long Term P/L for each symbol.

### Match Method for Each Security
Change the matching method for each symbol in the list of positions by clicking the drop-down. Select from FIFO, LIFO, Maximize LT Gain, Maximize LT Loss, Maximize ST Gain, Maximize ST Loss, Highest Cost or Specific
### Year-to-Date Summary

The YTD Summary screen displays a table of your year-to-date profit and loss (P/L) by symbol, including:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot.</td>
<td><strong>Show/Hide Button</strong> - Opens and closes the Tax Lot Details panel for a specific symbol. Click Show to open the Tax Lot Details panel; the button changes to Hide. Click Hide to close the Tax Lot Details panel; the button changes to Show.</td>
</tr>
<tr>
<td>11</td>
<td><strong>Tax Lot Details Panel</strong> - Displays all open lots and closing trades for a selected symbol, as well as the profit and loss for each open lot that is closed under the current matching method. Click the Show button next to each open lot or closing trade to open the Match Details window, which shows the open lot you selected and all possible sales that could be matched. If you change the matching method for a specific symbol to Specific Lot, the Show button changes to an Edit button. Click the Edit button to open the Match Details window to manually match to the open lot.</td>
</tr>
<tr>
<td>12</td>
<td><strong>Today’s Match Method for the selected security</strong> - The matching method for the selected symbol for today. Change this by clicking the drop-down and selecting a different method. Select from FIFO, LIFO, Maximize LT Gain, Maximize LT Loss, Maximize ST Gain, Maximize ST Loss, Highest Cost or Specific Lot.</td>
</tr>
<tr>
<td>13</td>
<td><strong>Show/Edit Button</strong> - Click this button to display the Match Details window, which displays a selected open lot and all possible sales that could be matched. The Edit button is enabled when you select Specific Lot as the matching method. Clicking the Edit button lets you manually match sales to open lots.</td>
</tr>
<tr>
<td>14</td>
<td><strong>YTD Summary tab</strong> - Click this tab to display a table showing a year-to-date summary of profit and loss by symbol.</td>
</tr>
</tbody>
</table>
Chapter 4

Changing the Lot-Matching Method from the YTD Summary

- Short-term profit
- Short-term loss
- Long-term profit
- Long-term loss
- Unrealized profit
- Unrealized loss
- Total profit and loss
- All amounts totaled at the bottom

Data is displayed based on the following rules:

- Short-term P/L and long-term P/L include today’s realized P/L plus YTD realized P/L.
- Unrealized P/L are calculated using the prior day's closing price but are not calculated for positions opened during the current day.
- All data is summarized by underlying CONID. For example, AAPL stocks, options and SSFs will appear in a single row for AAPL.

Changing the Lot-Matching Method from the YTD Summary

You can change the Account Default Match Method and Today’s Match Method from the YTD Summary. Simply click the Account Default Match Method or Today’s Match Method drop-down menu at the top of
the screen to change either lot-matching method.

The results of your change will be updated in the YTD Summary but only today’s closing trades will be affected by the change.
Menus

The Tax Optimizer includes the following menus:

**File**

- **Save** - Saves all of your lot-matching changes. This is the same as clicking the Save button.
- **Refresh** - Updates all data in the Tax Optimizer. This is the same as clicking the Refresh button. If you have made any lot-matching changes but have not saved them, they will be lost when you refresh.
- **Exit** - Exits the program. If you have made any lot-matching changes, you are prompted to save them.

**Help**

- **Online Users' Guide** - Opens the Tax Optimizer Users' Guide.
- **Feedback** - Lets you send your comments and suggestions to us via email.
- **About** - Opens the About box, which displays trademark and software version information.
Using the Tax Optimizer

Use the Tax Optimizer to:

» Change the default tax lot-matching method for your account.
» Change the default tax lot-matching method for today.
» Change the tax lot-matching method for a specific symbol.
» Run real-time what-if scenarios - change the lot-matching method on the fly to immediately see the effect on your gains and losses
» Manually match specific tax lots.

All profit and loss amounts in the Tax Optimizer are converted to the base currency of your account. However, prices are NOT converted to your base currency.

Change Your Account Default Match Method

To change your account default match method

1. Log into Account Management, then select Reports > Tax Optimizer.

2. Click Launch to run the Tax Optimizer.
If you log out of Account Management while the Tax Optimizer is open, you will not be able to save your changes in the Tax Optimizer.

3. For multi-account structures, select an account from the Account drop-down in the Information Bar.

4. Click the drop-down menu located next to the Account Default Match Method label at the top left of the screen.
Futures (but not Single Stock Futures) and options on futures always use FIFO regardless of your Account Default Match Method.

5. Click the lot-matching method you want to apply to your account as the default. Note that FIFO is the only matching method allowed for any short positions, including short positions entering the day.

6. Click the Save button, located in the upper right corner of the screen.

You have until 8:30 PM ET to make changes to your matching method. Check the Time Remaining at the top right corner of the Tax Optimizer screen to see how much time remains until the cut-off time of 8:30 PM.

**Change the Match Method for the Current or Prior Day**

You can change the default match method for the current or prior trading day in the Tax Optimizer. When you change the match method for the day and save the change, your selection overrides the default match method for the account until the end of the trading day today. The account default match method will then be in effect again tomorrow.

**To change today's match method**

1. Log into Account Management, then select **Reports > Tax Optimizer**.
2. Select the Trading Day. You can select the current trading day or the prior trading day. Note that if you are launching the Tax Optimizer on a Saturday or Sunday, you will only be able to select the prior trading day.

3. Click **Launch** to run the Tax Optimizer.
If you log out of Account Management while the Tax Optimizer is open, you will not be able to save your changes in the Tax Optimizer.

4. For multi-account structures, select an account from the Account drop-down in the Information Bar.

5. Click the drop-down menu located next to the Today's Match Method label at the top of the screen.

6. Click the lot-matching method you want to apply to your account as the default. Note that FIFO is the only matching method allowed for any short positions, including short positions entering the day.

7. Click the Save button, located in the upper right corner of the screen.

You have until 8:30 PM ET to make changes to your matching method. Check the Time Remaining at the top right corner of the Tax Optimizer screen to see how much time remains until the cut-off time of 8:30 PM.

For example, if you are working with the current trading day and you miss the 8:30 PM cut-off time, you can open the Tax Optimizer tomorrow and select the prior trading day and submit any changes you have. The 8:30 PM cut-off time will still apply. If you miss the 8:30 cut-off time for changes to lot-
matching methods for the prior trading day, you will not be able to submit any more changes for that specific trading day.

**Change the Match Method for a Specific Symbol**

You can change the default tax lot-matching method for a specific symbol in the Tax Optimizer on either the current or prior trading day.

**To change the match method for a specific symbol**

1. Log into Account Management, then select **Reports > Tax Optimizer**.

   ![Tax Optimizer](image)

2. Select the Trading Day. You can select the current trading day or the prior trading day. Note that if you are launching the Tax Optimizer on a Saturday or Sunday, you will only be able to select the prior trading day.

3. Click **Launch** to run the Tax Optimizer.
If you log out of Account Management while the Tax Optimizer is open, you will not be able to save your changes in the Tax Optimizer.

4. For multi-account structures, select an account from the Account drop-down in the Information Bar.

5. Select a security type by clicking the appropriate tab (Stocks, Options, Bonds, Warrants, SSFs or Funds). Note that Options include Structured products and Bonds include bills. The list is updated to include only those positions of the selected security type.

6. For any symbol listed, change the lot-matching method to Specific Lot by clicking the Method drop-down menu then clicking Specific Lot.
7. Click the **Save** button, located in the upper right corner of the screen.

You have until 8:30 PM ET to make changes to your matching method. Check the Time Remaining at the top right corner of the Tax Optimizer screen to see how much time remains until the cut-off time of 8:30 PM.

**Run What-If Matching Scenarios**

The Tax Optimizer lets you run real-time what-if matching scenarios. What-if matching scenarios allow you to change the lot-matching method on the fly for any symbol listed to immediately see the effect on your gains and losses. You open the Tax Lot Details panel to view the results of the change on your profit and loss.

You can make changes and save them until 8:30 PM ET on any given day. The amount of time remaining until 8:30 PM is displayed in the upper right corner of the screen.

**To change the match method for any symbol**

1. Log into Account Management, then select **Reports > Tax Optimizer**.
2. Select the Trading Day. You can select the current trading day or the prior trading day. Note that if you are launching the Tax Optimizer on a Saturday or Sunday, you will only be able to select the prior trading day.

3. Click **Launch** to run the Tax Optimizer.

   ![Tax Optimizer interface](image)

   The Tax Optimizer lists all or your positions of the selected security type, sorted alphabetically by symbol and showing the matching method, Short Term P/L and Long Term P/L for each symbol.

4. For multi-account structures, select an account from the Account drop-down in the Information Bar.

5. Select a security type by clicking the appropriate tab (**Stocks**, **Options**, **Bonds**, **Warrants**, **SSFs** or **Funds**). Note that Options include Structured products and Bonds include bills.

   The list is updated to include only those positions of the selected security type.
6. For any symbol listed, change the lot-matching method by clicking the Method drop-down menu then clicking the desired method. Select one of the following match methods:

- First In, First Out (LIFO)
- Last In, First Out (FIFO)
- Maximize LT Gain
- Maximize LT Loss
- Maximize ST Gain
- Maximize ST Loss
- Highest Cost
- Specific Lot - Specific Lot lets you manually match a tax lot with any available closing trade.

7. Click the **Show** button for the symbol to open the Tax Lot Details panel. (The **Show** button changes to a **Hide** button.)

The Tax Lot Details panel displays all open lots and closing trades for the selected symbol, as well as the profit and loss for each open lot that is closed under the current matching method.

8. Click the **Show** button in the Tax Lot Details panel for a specific lot to display the Match Details window, which displays the open lot you selected and all possible sales that could be matched. Click **Close** to close the Match Details window.
9. Continue to change the match method for the selected symbol in the Tax Lot Details panel by clicking the drop-down menu in the title bar of the Tax Lot Details panel.

10. Click the Show button for any symbol listed in the main section of the Tax Optimizer to automatically update the data in the Tax Lot Details panel.

11. Close the Tax Lot Details panel by clicking the Hide button for the selected symbol.

12. Click Save to save your changes, or Refresh to update the data in the Tax Optimizer without saving your changes.

Saving your changes applies the selected matching method(s) to the actual sales for tax purposes.

**Manually Match Specific Lots**

The Specific Lot matching method lets you see all of your tax lots and closing trades, including voluntary corporate actions, and manually match lots to trades. Specific Lot is available for today or a specific position, but is not available as the Account Default Match Method.
You can make changes and save them until 8:30 PM ET on any given day. The amount of time remaining until 8:30 PM is displayed in the upper right corner of the screen.

**To use the Specific Lot match method to manually match lots to trades**

1. Log into Account Management, then select **Reports > Tax Optimizer**.
2. Select the Trading Day. You can select the current trading day or the prior trading day. Note that if you are launching the Tax Optimizer on a Saturday or Sunday, you will only be able to select the prior trading day.
3. Click **Launch** to run the Tax Optimizer.

4. For multi-account structures, select an account from the Account drop-down in the Information Bar.
5. Select a security type by clicking the appropriate tab (Stocks, Options, Bonds, Warrants, SSFs or Funds). Note that Options include Structured products and Bonds include bills.

The list is updated to include only those positions of the selected security type.

6. For any symbol listed, change the lot-matching method to Specific Lot by clicking the Method drop-down menu then clicking Specific Lot.

7. Click the Show button for the symbol to open the Tax Lot Details panel. (The Show button changes to a Hide button.)

The Tax Lot Details panel displays all open lots and closing trades for the selected symbol, as well as the profit and loss for each open lot that is closed under the current matching method.
8. Click the **Edit** button in the Tax Lot Details panel for a specific lot to display the Match Details window, which displays the open lot you selected and all possible sales that could be matched.

Only those lots that are currently open (O appears in the Open/Close column of the Tax Lot Details panel) and unmatched (a quantity appears in the Unmatched Open Quantity column) can be manually matched.
9. In the Match Details window, for each sale that you want to manually match to the open lot type the number of shares or contracts in the Matched Open Qty field, then press Enter.
   - The Matched Open Qty and Unmatched Open Qty for the current working lot is updated at the top of the Match Details window.
   - The P/L is calculated and applied to the session, and displayed in the current window as well as in the main Tax Optimizer window.
   - The closing trades and available quantities to match are also refreshed.

10. To undo ALL manual matches for a selected symbol, open the Match Details window for a specific lot, then click Reset SYMBOL (where SYMBOL is the current working symbol) to remove all Matched Open Quantities that you previously entered.
11. To clear only the matches for the current working open log, click Reset Lot.
12. At any time, click Close to close the Match Details window without making any manual changes.
The Tax Optimizer will not let you save your changes until all available lots for a specific symbol have been manually matched.

13. To change Today's Match Method to Specific Lot, click the drop-down menu next to the Today's Match Method label, then click Specific Lot.

   The match method for all symbols listed changes to Specific Lot, except incoming short positions.

   ○ You must now manually match all sales to lots in the Match Details window as described in the previous steps.

14. Click **Save** to save your changes, or **Refresh** to update the data in the Tax Optimizer without saving your changes.

   Saving your changes applies the selected matching method(s) to the actual sales for tax purposes.

   If you select Specific Lot as your match method but you do not manually match available lots, then close the Match Details window (or exit the Tax Optimizer) without saving, a message appears to remind you that there are unmatched lots and that the default matching method for today will apply.
Therefore, if you select Specific Lots, be sure to manually match all available lots then save your changes, or Today's Match Method will apply to those lots by default.

**For more information**

- **Specific Lot Example**

**Corporate Actions**

Corporate actions may produce scenarios where symbol A depends on symbol B. The Tax Optimizer handles these scenarios as follows:

- If B is changed to specific lot, A will automatically be switched to specific lot as well.
- If B is not fully matched and you attempt to specific lot match A or change A's match method, a warning message is displayed: "Before matching A, the following must be fully matched: B."

Voluntary corporate actions are identified in the Tax Lot Details panel by a small "C" icon, as shown circled in the image below.
The Match Details window also identifies corporate actions with a small "C" icon, as shown below.
Specific Lot Example

The following simple example demonstrates how to use the Specific Lot matching method.

1. A client makes the following trades:
   - **Lot 1** - January 15, 2012 at 2:00PM: buy 100 shares ABC for $10 per share ($1,000 total).
   - **Lot 2** - January 30, 2013 at 10:00AM: buy 100 shares ABC for $12 per share ($1,200 total).
   - **Sale 1** - January 30, 2013 at 11:00AM: sell 100 shares ABC for $14 per share ($1,400 total).
   - **Sale 2** - January 30, 2013 at 12:00PM: sell 100 shares ABC for $8 per share ($800 total).
   - **Lot 3** - January 30, 2013 at 1:00 PM: buy 100 shares ABC for $11 per share.
   - **Lot 4** - January 30, 2013 at 2:00PM: buy 100 shares ABC for $9 per share.
   - **Sale 3** - January 30, 2013 at 3:00PM: sell 100 shares ABC for $6 per share.

2. In the Tax Optimizer, the client selects Specific Lots as his matching method for symbol ABC, then clicks the Show button to display the Tax Lot Details panel.
   - If the client clicks the Edit button in the Tax Lot Details panel for Lot 1 or Lot 2, the Match Details window displays Sales 1 and 2. The client can match Lot 1 or 2 to Sale 1 or 2.
   - If the client clicks the Edit button for Lot 3 or Lot 4, the the Match Details window displays Sale 3. Lot 3 or 4 can only be matched with Sale 3.

The client cannot match Lot 1 or Lot 2 with Sale 3.

The client cannot match Lot 3 or Lot 4 with Sale 1 or Sale 2.

For example:

- The client could match Lot 1 with Sale 1 for a long-term gain of $400.
- He would then have to match Lot 2 with Sale 2 for a short-term loss of $400.
- The client could then match Lot 3 with Sale 3 or 4. If he matches Lot 3 with Sale 4 for a short-term gain of $500, he would have a net long-term gain of $400, a net short-term loss of $900, and a basis of $900 and a holding period beginning January 30, 2013 for the remaining open lot.

Or:
The client could match Lot 1 with Sale 2 for a long-term loss of $200.
He would then have to match Lot 2 with Sale 1 for short-term gain of $200.
If the client matches Lot 3 with Sale 3 for a short-term loss of $200, he would then have a net long-term loss of $200, no net short-term gain or loss, and a basis of $600 and a holding period beginning January 30, 2013 for the remaining open lot.

**Exit the Tax Optimizer**

To exit the Tax Optimizer, do one of the following:

- Click **File > Exit**.
- Click the X in the upper right corner of the Tax Optimizer window.

If you have NOT saved any of your changes, they will be lost when you close the Tax Optimizer.

If you leave the Tax Optimizer running without properly exiting, it will automatically shut down at 11:59 PM ET.
Index

A

about tax lots 4

account default match method 27

C

changing match method for current or prior day 29
changing the account default match method 27
changing the match method for a specific symbol 32
changing the matching method for a specific symbol 34
closing the Tax Optimizer 46
corporate actions; matching specific lots

    corporate actions; 43

E

example

    specific lot 45

examples 7

    Highest Cost 13

exit the application 46

F

FIFO 5
Chapter 4

Index

H

Highest Cost 6
  example 13

how to start the Tax Optimizer 14

I

introduction 3

L

launching the Tax Optimizer 14

LIFO 5

lot-matching method examples 7

lot-matching methods 5

M

main window 17

manually match lots 37

Match Details window 19

match method
  account default 27

  changing for a specific symbol 32

  for specific symbols 34

  for the prior day 29

  for today 29

  matching methods 5
Maximize LT Gain 5
Maximize LT Loss 6
Maximize ST Gain 6
Maximize ST Loss 6
menus 26
methods 5
methods of matching 5
O
overview 3
P
parts of the screen 20
prior day match method 29
R
running the Tax Optimizer 14
S
specific identification 5
Specific Lot 6, 37
   example 45
symbol
      changing match method for 32
T
Tax Basis Declaration 4
Tax Lot Details panel 18, 34

tax lot selection overview 4

Tax Optimizer

using 27

Tax Optimizer screen 20

Tax Optimizer tasks 3

Tax Optimizer window 17

U

using the Tax Optimizer 27

W

what-if matching scenarios 34

window 17

Y

year-to-date summary screen 23

YTD summary 23

changing lot-matching method from 24